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Creating prescriptions and managing 
medications
In Wolf EMR, you can create and print prescriptions from any window related to a patient’s 
record (via the SMART menu).

Once a medication has been prescribed for a patient, you can:

 Reprint the prescription

 Modify the prescription

 Refill the prescription

 Discontinue the prescription

Wolf EMR tracks a patient’s active (current) and inactive (previous) medications in the Medical 
Summary, and displays the patient’s medications and allergies in the Prescription entry window. 
This allows you to view pertinent information at-a-glance when you prescribe new medications. 

Creating prescriptions
You can prescribe a medication from almost any window related to a patient via the SMART 
menu. Wolf EMR contains an extensive searchable medications list, enabling you to quickly 
select an appropriate medication to prescribe.

You can enter prescription directions using discrete entry fields (for example, for dose, 
frequency, and duration), or you can enter prescription directions as free-text. Using a variety of 
search and entry options, you can create:

 Basic prescriptions (see “Creating basic prescriptions” on page 2) 

 PRN prescriptions (see “Prescribing PRN (take-as-needed) medications” on page 13)

 Prescriptions for compound medications (see “Prescribing compound medications” on 
page 14)

 Variable dose prescriptions (see “Prescribing variable doses” on page 15)

 Prescriptions for medical devices and other non-medication treatments (see “Prescribing 
medical devices and other non-mediation treatments” on page 16 and “Prescribing 
medical devices and other non-medication therapies using SMART Forms” on page 17)
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 Prescriptions for over-the-counter (OTC) and intravenous medications (see “Prescribing 
over-the-counter (OTC) and intravenous medications” on page 18)

You can print more than one medication on a single prescription printout (see “Prescribing 
multiple medications” on page 11). Additional medications can be new medications for the 
patient, or refilled medications.

If you prescribe multiple medications, the EMR tracks the medications in a visible area, enabling 
you to review your prescribed medications before printing the complete prescription.

Creating basic prescriptions

When you create a basic prescription, you search for a medication to prescribe, and then enter 
prescription instructions using discrete entry fields (for example, for dose, frequency, and 
duration). If you enter complete dosage information, the EMR can calculate a quantity 
automatically.

When you finish a prescription, you can choose to print the prescription or, if you are 
prescribing multiple medications, you can also choose to save the prescription.

Steps

1. Open the Add New Medications window: On any window related to a patient’s record 
(including the SOAP form, the Consult Letter form, the Medical Summary, a patient 
message/Follow up, or the Patient tab) right-click and then in the SMART menu, click Enter 
New Medication. The EMR displays the Add New Medications window, with:

 The medication search area located in the top left area of the window.

 A list of your medication favourites displayed in middle of the window.

 The patient's weight, age, and allergies displayed on the top right of the window.

 The prescription dosage entry area located on the bottom of the window.
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2. Search for a medication to prescribe using one of three methods:

To search by medication name:

a) In the Search field, enter part or all of the medication name.

b) To narrow or expand your medication search criteria, using the following table, select or 
clear filtering options.

 
Option Description

Starts with Displays only medications with names that start with your search 
term.

Contains Displays medications with names that contain (but do not have to 
start with) your search term.

Dose Form To display only medications that are available in a specific form (for 
example, “capsule”), in the drop-down list, select an option.

Include Generic Includes non-brand-name medications in your search results.

Include OTC Includes over-the-counter medications in your search results.

Include IV Includes intravenous medications in your search results.
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c) Press Enter. The EMR displays matching medications in the Select medication from 
list area.

  

d) In the Select medication from list area, click the medication you want. To search for a 
medication by category:

a) Click the Drug Category Search tab. The EMR displays a list of high-level drug 
categories.

Tip: You can change what medication search options are selected for you by 
default: 

1. In the WorkDesk menu, click Configure > Configure Workdesk.

2. Click the Medications tab.

Note: Users with administrative authority in Wolf EMR can set medication search 
option defaults for the entire clinic. See “Setting defaults for medication 
search options” on page 53.

Medication search tips

 In the medication search results list, if a medication displays more than once, 
there are multiple dosage types for that medication. To view the dosage type 
and size, click and then hover your cursor over the medication name. The EMR 
displays the dosage type and size as a pop-up message.

 You can narrow your search results by selecting the form you want the 
medication to be in. For example, to search for amoxicillin in capsule form, in 
the Dose Form drop-down list, click CAP. The search results return all 
amoxicillin options available in capsule form.

 If you are searching for an over-the-counter medication, in the Search area, 
select the Include OTC check box.

 If you are searching for a brand name medication, clear the Include Generic 
check box. 

Best practice: If you are not certain how to spell a medication name, in the 
Search field, enter only the first three letters of the medication name. Wolf EMR will 
not produce accurate search results for misspelled names. 
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b) Click in the Drug Category Search area and then, on your keyboard, press the first 
letter of the category you want to select. For example, press "c" for “central nervous 
system agents”. The EMR displays that area of the alphabetical list.

c) Scroll down the list, and then click the category you want. The EMR displays associated 
sub-categories to the right.

d) Click a sub-category. In the Select medication from list area, the EMR displays a list of 
medications classified within that sub-category.

e) Click the medication you want. 

To search for a medication by a targeted system for treatment:

a) Click the Search by ATC Categories tab. The EMR displays a list of high-level targeted 
systems.
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b) Choose the system you are targeting for treatment. In the Select medication from list 
area, the EMR displays a list of associated medications.

c) To narrow your search results to a specific drug category that targets your selected 
system, expand a system name. and then select a category.

d) To narrow your search further to a specific drug sub-category that targets your selected 
system, expand a category name, and then choose a subcategory. 

e) In the Select medication from list area, click the medication you want. 

The EMR:

 Displays the selected medication name in the blue RX field

 Populates the prescription details area with default values (if available).

Note: “ATC” = “Anatomical Therapeutic Chemical”
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3. Using the following table, in the prescription details area (located on the bottom right of the 
window), enter or modify the prescription details.

 

Note: If the selected medication has prescription defaults set, the Dose, 
Frequency, Duration, PRN, Anticoagulant and Notes fields and check boxes 
may auto-populate. You can edit these default values if needed.

For information on how to set and modify medication prescription defaults, see 
“Modifying prescription defaults for medications” on page 58.

Note: Depending on the medication you choose, several of the prescription detail 
fields may populate with default values. You can edit default values if needed.

Field Description

Dosage Below Dosage, choose a dosage option (for example, for a 250mg 
tablet, click 250). If the option you want is not available, enter the 
dose in the Dosage field.

Units In the drop-down list, select the dose units. For example, for a 
250mg tablet, select mg.
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4. Review possible drug interactions warnings. See “Prescribing multiple medications” on page 
11.

5. Click Prescribe. The EMR opens the Prescriptions window, with:

Route In the drop-down list, select the dose route. For example, for a tablet 
that the patient is to take orally, select PO (per Orally).

Units/Dose Below Units/Dose, click the number of units the patient is to take 
with each administration. If the number you want is not available, 
enter a number in the Units/Dose field (for example, 1/2, i,ii).

Frequency list In the list of frequency options, select a frequency, or to indicate that 
the patient is to take the medication as needed, select prn.

Problem To associate the prescription with a one of the patient’s Medical 
Summary problems, in the drop-down list, click a problem. 

Note: You can choose only problems that are listed in the patient’s 
problem list. To add a problem to the patient’s problem list, 
select <Add New>.

Duration In the drop-down list, click a duration. If you are having trouble finding 
the duration you want, in the Duration field, start to enter the 
duration (for example, to find “4 days”, enter “4”). The EMR takes you 
to the appropriate area on the list.

Note: The Duration option you select determines if and when the 
medication automatically discontinues. If you expect to refill 
the medication, click No Cut Off. 

Note: In # Days is selected, then the Single Rx option is selected 
on the Prescription window.

Date Prescribed By default the Date Prescribed is today’s date. To set the prescription 
date to another date, enter the date, or to select the date from a 

calendar, click .

Anticoagulant f this is an anti-coagulation medication that requires regular INR 
testing, select the Anticoagulant check box. The EMR displays the 
prescription, and future changes you make to the prescription, on 
the Anticoagulation Summary Sheet.

Note: The Anticoagulant check box displays only if your 
medication is flagged by the EMR as an anticoagulant.

Notes Enter any additional prescription notes for the patient (for example, 
“take immediately following a meal”).

Field Description
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 The left side of the window displaying lists of the patient’s current Medications, Previous 
Medications, and Allergies.

 The right side of the window displaying the input area for the current prescription’s 
quantity, repeats, and duration details.

 

6. Using the following table, enter additional prescription details.

Tip: You can go back to the previous window (New Mediation window) at any 
time. At the top of the Prescriptions window, click Edit Medication Dosing 

( ).

Tip: Use your Tab key to jump from field-to-field.
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Field Description

Rx Date Today’s date is selected by default. To set the prescription date to 
another date, enter the date, or to select the date from a calendar, 

click .

Prescribing MD If you have prescribing authority in Wolf EMR, your name is selected 
by default. If you are creating a prescription on behalf of another 
provider, in the drop-down list, select the provider’s name.

May Substitute 
Generic

This option is selected by default. 

If the pharmacist should not substitute another brand, select No 
Substitutions instead.

No 
Substitutions

If the pharmacist should not substitute another brand, select this 
check box.

Print 
Medications 

If you want the patient’s complete list of active medications to display 
on the prescription print-out, select this check box (if it is not already 
selected), otherwise, clear this check box.

Tip: You can choose if this check box is selected by default. Users 
with administrative authorities can enable or disable this default 
option for you. See “Setting prescription printouts to include patient 
medication lists by default” on page 61.

Quantity perform one of the following actions

 To enter the medication quantity manually, enter the total amount 
of medication to be dispensed (for example, the number of 
capsules).

 To have the EMR calculate the quantity for you, enter the duration 
the patient is to take the medication for.

Note: If you enter frequency and duration information in the Add 
New Medication window; then the Quantity field is already 
populated with the calculated number of tablets, applications, 
etc.

Units Choose the appropriate quantity or duration units.

Repeats Enter the number of repeats, or to indicate that you do not want any 
repeats, leave the field blank.
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7. If the prescription requires a PharmaCare Special Authorization form, complete the Special 
Authorization form. See “Requesting PharmaCare Special Authority for prescriptions” on 
page 25.

8. Perform one of the following actions:

 To print the prescription on your default printer, click Quick Print ( ).

 To select a printer or fax machine to print from, click Print ( ).

 To save the current prescription and to prescribe another medication, click Enter New 

Medication ( ). See “Prescribing multiple medications” on page 11.

 To save the prescription, and print it later, click Close and Save( ).

After the prescription prints, the EMR changes the prescription Status to 'Printed'. The 
medication is recorded in the patient’s Medical Summary, and in the patient’s Medications 
list on the Prescriptions window.

.

Prescribing multiple medications

If you prescribe or refill more than one medication during a visit, you can print the medications 
on a single prescription printout.

As you prescribe multiple medications, the EMR tracks the medications in the Current Refill 
area, enabling you to review your prescribed medications before printing.

Duration Select one of the following options:

 To indicate that the patient will be on the medication for an 
extended period of time. select Long Term.

 To indicate that the patient to be on the medication only until the 
prescription runs out, select Single Rx.

Start Date If the patient is to start taking the prescription on a day other than 
today, enter a new start date, or to select a date on a calendar, click 

.

Note: If a locum prints a prescription, Wolf EMR adds the text “Locum For ‘X’ 
Physician” to the prescription print-out.

Field Description
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Steps 

1. Prescribe the first medication. See Step 1 to Step 7 in “Creating basic prescriptions” on 
page 2.

2. In the Prescriptions window, perform one of the following actions:

 To prescribe a medication that has not been previously prescribed to the patient:

a) Click Add/New ( ). The previous medication is saved and the Add New 
Medications window opens. 

b) Search for the next medication and then enter prescription details. See Step 1 to Step 
7 in “Creating basic prescriptions” on page 2.

 To re-prescribe one of the patient’s active medications, refill the prescription. See Step 2 
to Step 4 in “Refilling a single prescription (for active medications)” on page 41.

 To re-prescribe one of the patient’s inactive medications, resume the prescription. See 
Step 2 to Step 5 in “Resuming previous medications” on page 42.

3. To add additional medications to the prescription, repeat Step 2. As each medication is 
added to the prescription, the EMR displays the medication name in the Current Refill 
area. In the Medications area, the word Refilled also displays beside the medication’s 
name.
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4.  To print the prescription, click one of the following options:

 Quick Print ( ): To print the prescription to your default printer.

 Print ( ): To select a printer or fax machine to print to.

Prescribing PRN (take-as-needed) medications

When you prescribe a PRN (take-as-needed) medication, for example, a pain medication or an 
inhaler, you do not need to specify a dose, frequency, or duration as long as you enter a 
quantity. If needed, in an open-ended text field, you can enter detailed information such as:

 In what situations or cases patient is to take the medication

 What dose should be administered depending on the situation

 The maximum amount of medication the patient can take in a day

 The minimum amount of time required between doses 

Steps 

1. Search for and select a medication to prescribe. See Step 1 to Step 2 in “Creating basic 
prescriptions” on page 2.

2. On the Add New Medications window, click OverRide (located below the blue Rx field). 
The EMR enables you to edit text in the blue Rx field.

3. In the Rx field, click to the right of the medication name, and enter "PRN", followed by 
prescription directions. Directions can include:

 Circumstances in which the patient is to administer the medication

 Maximum dose per day

 Minimum amount of time between doses

Tip: If you add a medication in error and want to remove it from your prescription, 
double click the medication on the Current Refill list.

Note: All medications that display in the Current Refill area on the Prescriptions 
window are included in the printout.
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4. Optionally, enter information in the dose, units, and frequency fields. See Step 3 in 
“Creating basic prescriptions” on page 2.

5. Complete the remainder of prescription as you would for a basic prescription. See Step 5 
Step 8 in “Creating basic prescriptions” on page 2.

Prescribing compound medications

Compound prescriptions are medications comprised of two or more ingredients that are 
combined by a pharmacist before dispensing. The multitude of potential compound ingredient 
combinations are not specifically available in the Wolf EMR’s drug database.

Because you cannot select the whole compound from the medication search list, you instead 
search for the first ingredient. You can then customize the Rx name to include the remainder of 
the compound ingredients. 

Steps 

1. Start a prescription as normal, and then search for the first compound ingredient. See Step 
1 to Step 2 in “Creating basic prescriptions” on page 2.

2. Below the blue Rx field, click OverRide. The blue Rx field becomes editable.

3. In the Rx field, click to the right of the first ingredient’s name, and then enter the remainder of 
the compound ingredients as you want them to display on the prescription.

 

4. In the Rx field, beside the compound name, you can also enter your prescription directions.

Note: Do not erase or modify the medication name that is populated by the EMR.

Note: The name of the first ingredient must remain as is. You cannot edit it.
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5. Optionally, enter information in the dose, units, and frequency fields. See Step 3 in 
“Creating basic prescriptions” on page 2.

6. Complete the remainder of prescription as you do for a basic prescription. See Step 5 Step 
8 in “Creating basic prescriptions” on page 2.

 

Prescribing variable doses

Variable dose prescriptions are prescriptions where dose changes from week-to-week, day-to-
day, or within a day. Some examples include:

 Weening a patient off of a medication by reducing their daily dose each week.

 Instructing a patient to take one capsule in the morning than two capsules in the evening. 

These types of prescriptions often have extensive instructions that require greater flexibility for 
entering.

Steps 

1. Search for and select a medication to prescribe. See Step 1 to Step 2 in “Creating basic 
prescriptions” on page 2.

2. Below the blue Rx field, click OverRide. The blue Rx field becomes editable.

3. In the Rx field, click to the right of the medication name, and then enter the prescription 
directions. For example, “Tapering - 8 tabs x 1 day; 7 tabs x 1 day...”

4. Leave the Dose, Units, and Frequency fields blank. 

5. Complete the remainder of prescription as you do for a basic prescription. See Step 5 Step 
8 in “Creating basic prescriptions” on page 2.

Note: Compounds are not checked for interactions or low/high dosages since 
these prescriptions are entered in as text only.

Best practice: Select the most basic version of a medication name. If 
possible, do not select a medication with a pill/capsule/application size 
specified in it’s name.
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Prescribing medical devices and other non-mediation treatments

You can create prescriptions for a number of non-medication treatments, including injections, 
therapies, and medical devices. If your clinic has added common non-medication treatments to 
your EMR’s medication database, when you create a prescription, you can search for non-
medication treatments similar to how you search for medications. If the treatment you want is 
not in the medication database, you search for “Non Medication”, and then you can modify this 
name to indicate the treatment.

Steps 

1. Open the Add New Medications window. See Step 1 “Creating basic prescriptions” on page 
2.

2. In the Search field, enter part or all of the treatment name (for example, “Brace”), and then 
press Enter. The EMR displays a list of matching treatment/device options in the Select 
medication from list area.

3. Click the appropriate device/treatment. The EMR displays the medical device/treatment 
name in the blue Rx field.

4. If the search produces no matches for the treatment you want: 

a) In the Search field, enter Non Medication, and then, on your keyboard, press Enter. 

b) In the Select medication from list area, click “Non Medication”. 

Tip: For information on how to add non-medication treatments to your EMR’s 
medication database, see “Adding custom treatments to the medication list” on 
page 62.

Best practice: Enter only one word as your treatment search term, as the EMR is 
more likely to find a match. For example, enter “brace” instead of “carbon fiber 
knee brace.” You can then select a more specific description from the resulting 
search list.
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c) In the blue Rx field, enter the treatment name beside the words "Non Medication": Click 
OverRide, and then the blue Rx field becomes editable.

5. To free-type your prescription directions:

a) Click OverRide and then, in the Rx field, beside the treatment name, enter your 
directions (for example, carbon knee brace - to be worn during weight-bearing following 
ACL surgery on the right knee).

6. Optionally, enter information in the Dose, Units, and Frequency fields. See Step 3 in 
“Creating basic prescriptions” on page 2.

7. Complete the remainder of prescription as you would for a basic prescription. See Step 5 
Step 8 in “Creating basic prescriptions” on page 2.

Prescribing medical devices and other non-medication therapies using SMART 
Forms

If you want a printed prescription for a medical device, therapy, and other non-medication 
treatment to contain your clinic logo and other customized features, you can use a customized 
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SMART Form as your “prescription pad”. Before you can prescribe using this method, you must 
create a custom SMART form for prescriptions. For details on how to create custom SMART 
forms, see the Wolf EMR SMART Form User Guide.

Steps 

1. On any window related to the patient, (including a patient’s Medical Summary, SOAP form, 
Consult Letter Examination form, or Patient tab [CPP]), right-click and then, in the SMART 
menu, click SMART Forms. The Send to SMART Form window opens. 

2. In the left pane, expand Letters. The EMR displays a list of letter SMART Forms.

3. In the list, double click Physio Chiro Massage Referral (or the name of your clinic’s 
customized prescription SMART Form). The your prescription template opens in Microsoft 
Word.

4. In the Word document, enter the device or treatment prescription details.

5. To print the prescription:

a) On the Microsoft Word menu, click File > Print.

b) In the Printer drop-down list, select a printer.

c) Click Print ( ). The prescription prints, and the EMR saves a copy of the printed 
prescription in the Documents tab on the patient’s Medical Summary.

Prescribing over-the-counter (OTC) and intravenous medications

In Wolf EMR, over-the-counter (OTC) and intravenous medications are categorized differently 
than other medications, and by default do not display in medication search results. Before you 
search for an OTC or intravenous medication, you must indicate that medication search results 
can contain OTC or intravenous medications.

Steps 

1. Open the Add New Medications window. See Step 1 “Creating basic prescriptions” on page 
2.

2. In the Search area, select the Include OTC check box, or the Include IV check box 
depending on the type of medication you are prescribing.

Best practice: Use SMART forms only for NON-MEDICATION prescriptions. 
Always enter prescriptions for medications in the Add New Medications window. 
This way, you can easily reference, re-prescribe, and flag prescribed medications 
for possible interactions.
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3. Search for the medication and then complete the prescription as normal. See Step 2 to 
Step 8 in “Creating prescriptions” on page 1.

Recording externally prescribed medications
If you want to record that a patient is taking, or has previously taken, a medication but you do 
not want to prescribe the medication at this time, you can record the medication as an external 
medication. 

The quickest way to record external medications is by using Quick Entry. Quick Entry allows you 
to record only basic medication information; you are not required to enter any details about the 
dose, frequency, duration, and so on. You are only required to search for and select the 
medication, or to manually enter the medication name if it is a compound.

Steps 

1. On any window related to a patient’s record, right-click and then in the SMART menu, click 
Quick Entry. The Quick Entry Form window opens.

2. Click the Medications tab.

3. If the treatment is available in the Wolf EMR medication database:

a) In the Search field enter part or all of the medication name, and then press Enter.

Tip: If you want Include OTC and Include IV to be selected by default, users 
with administrative privilege can change configuration Wolf EMR to have these 
options selected by default. See “Setting defaults for medication search options” 
on page 53.

Note: You cannot print external medications. Instead, you must refill the 
prescription and then print it. See “Refilling prescriptions” on page 40.
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b) In the list of matching medications, click the medication you want. The selected 
medication populates the Rx field. The EMR also displays dosage, and frequency entry 
fields.

c) Optionally, enter dosage and frequency information. 

Note: If your clinic has prescription defaults set up for the treatment, the dosage 
and frequency fields populate automatically. You can modify this information as 
needed. 

If you do not want any dosage and frequency information included, click 
OverRide, and then, in the Rx field, beside the treatment name, delete the 
directions.

Tip: When you refill the prescription later, the dosage and frequency information 
you record here will populate the prescription automatically. Recording the 
information now will save you time later.
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4. If the treatment is a compound medication, or another treatment that is not available in the 
Wolf EMR medication database, click OverRide and then, in the Rx field, enter the 
treatment name, and optionally any prescription directions.

5. To associate the treatment with one of the patient’s listed problems, in the Problem drop-
down, select the problem. Or to add a problem to the patient’s problem list, and then 
associate the treatment to the new problem, select <<Add New>>.

6. To set a default pharmacy for this treatment, in the Default Pharmacy drop-down list, 
select the pharmacy.

7. In the Start Date field, enter the date the patient began taking the medication. The field 
defaults to today’s date.

8. If the treatment is a previous medication that should display in the patient’s Previous 
Medications list, in the D/C Date field, enter the date the treatment was discontinued.

9. Click Select >>. The medication is added to the patient’s medications list.
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Managing interaction warnings 
When you prescribe or refill a medication, the EMR checks the medication against the Cerner 
Multum database for:

 Drug-to-allergy interactions (with allergies and intolerances listed in the patient’s Active 
Allergies)

 Drug-to-drug interactions (with drugs listed in the patient’s Active Medications list)

 Drug-to-condition interactions (with conditions listed in the patient’s Problems list) 
  

If any interactions are found, you may be prompted with a pop-up warning. You can configure 
the EMR to not display pop-up warnings, and instead allow you to manually check for 
interaction warnings. You can also configure the EMR to not check for interactions at all. See 
“Configuring interaction warnings” on page 56.

When you receive an interaction warning, the EMR lists a summary of drug interactions and 
then provides full details about the interactions.

Steps 

1. Select a medication to prescribe, and then record any dose, frequency and duration 
directions. See Step 1 to Step 3 in “Creating basic prescriptions” on page 2.

2. If your EMR is configured to not display interaction warnings as pop-up notifications, at the 

top of the Add New Medications window, click Multum ( ). If interactions are found, 
the EMR opens the Drug Interaction Warnings window, containing a list of all identified 
interactions, followed by complete details about the interactions. If your WorkDesk is 
configured to display interaction notifications automatically, as soon as you select a 
medication to prescribe, if the EMR identifies any interactions, the Drug Interaction Warnings 
window pops-up.

Best practice: If a patient is no longer taking a medication, but the medication is 
listed in the patient’s Active Medications list, always discontinue the medication. 
This way, you will not receive interaction warnings against irrelevant medications.

Important: The EMR does not check for high or low dosages. For example, if you 
prescribe a medication dose that is too high for the patient’s weight or age, you are 
not notified.
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3. Using the following table, manage any interaction warnings.

To do this... Complete the following steps...

Continue to prescribe 
the medication despite 
the warning(s)

Perform one of the following actions: 

 To record a reason for continuing with the prescription, in 
the Override Reason (optional) field, enter your reason, 
and then close the window.

 If you do not want to enter an override reason, close the 
Drug Interaction Warnings window. 

You can now continue on with the prescription. 

Prescribe an 
alternative medication 

1. Close the Drug Interaction Warnings window.

2. In the Add New Medications window, search for a new 
medication to prescribe.
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Discontinue the 
medication that 
interacts with the 
medication you are 
prescribing

1. Close the Drug Interaction Warning(s) window.

2. Right-click the Add New Medications window and then, in 
the SMART menu, choose View Medication List.

3. Discontinue the medication. See “Discontinuing 
medications” on page 37.

4. You can now prescribe the medication without an 
interaction.

Remove an allergy or 
intolerance from the 
patient’s Active 
Allergies list (for 
example, because the 
allergy or intolerance 
is unsupported, or was 
recorded in error)

1. Close the Drug Interaction Warning(s) window.

2. Right-click the Add New Medications window and then, in 
the SMART menu, choose View Medical Summary.

3. In the Current Hx tab, in the Allergies area, double-click 
the allergy you want to remove. The selected allergy 
opens in the Allergy List window.

4. In the Clinical Status drop-down, select one of the 
following options:

 Resolved

 Refuted 

 Terminated and Reclassified.

5. Optionally, in the Note field, enter your reason for 
removing the allergy.

6. Click Save & Close ( ).

7. You can now prescribe the medication without an 
interaction.

To do this... Complete the following steps...
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After the prescription is saved. The EMR displays your over ride reason(s) in the patient’s 
Medication Profile. See “Viewing a patient’s medication profile” on page 34.

Requesting PharmaCare Special Authority for prescriptions
In Wolf EMR, you can complete and print the PharmaCare Special Authority Request form as 
you enter a prescription (via the Prescription window). You can also print the form for a 
previously entered prescription.

The EMR completes a majority of the form for you, requiring that you only:

 Select the Indication For Special Authority

 Enter specified details for special authority

Steps 

1. Search for a medication to prescribe, and then enter any prescription directions. See Step 1 
to Step  in “Creating basic prescriptions” on page 2.

2. Perform one of the following actions:

 If you are in the process of entering the prescription, at the top of the Prescriptions 

window, click Spec Auth ( ). 

 If you want to print a Special Authority form for a previously entered prescription, open the 

Medication Profile window, click the medication, and then click Spec Auth ( ). See 
Step 1 to Step 2 in“Editing prescriptions” on page 36.

Stop the prescription 1. Close the Drug Interaction Warning(s) window.

2. Close the Add New Medications window. 

Note: PharmaCare Special Authority grants full benefit status to a drug, medical 
supply or medical device that otherwise would not be covered or only partially 
covered. Coverage is provided for patients with specific medical circumstances 
and the actual reimbursement depends on the patient’s PharmaCare plan rules, 
including any annual deductible requirements.

Note: For the patient to receive coverage, they must ensure that Special Authority 
approval is in place before they purchase the prescription. Coverage is not 
provided retroactively.

To do this... Complete the following steps...
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The BC Reference Based Pricing Special Authority Form window opens.

3. In the Indication For Special Authority area, select an option.

4. In the Specific Details area, enter detailed information regarding the reason for special 
authority.

5. To print the Special Authority form, perform one of the following actions:

 To print the form on your default printer, click Quick Print ( ).

 To print the form on another printer, click Print ( ). The EMR displays a printer 
selection window. Click the printer you want, and then click Print.

The EMR prints the official provincial form with all fields completed.
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Reprinting prescriptions
If a patient loses or forgets their prescription, you can re-print the original prescription at any 
time.

Steps 

1. On any window related to the patient’s record, right-click and then, in the SMART menu, 
click Refill Medications. The Prescriptions window opens.

2. On the Prescriptions window, in the Rx Date field, enter the date of the original prescription, 

or to select the date on a calendar, click . The EMR displays all medications prescribed 
on the selected date in the Current Refill area.

 

3. Optionally, modify any of the listed medications’ prescription details. See “Editing 
prescriptions” on page 36.

4. To print the prescription, click one of the following options:

 Quick Print ( ): To print the prescription to your default printer.

 Print ( ): To select a printer or fax machine to print to.

Medication favourites
If you prescribe certain medications frequently, you can add these medications as favourites. 
When you prescribe favourite medications, you can simply choose the medication in your 
favourites list and the EMR populates the prescription directions automatically. You can then 
make modifications to the prescription directions as needed before printing the prescription.

Medication favourites also enable you to reduce the amount of time it takes to produce 
prescriptions with long or complicated details (for example, tapering medications and 
compound medications)

Tip: if you do not know the date the original prescription was created, you can 
view the start dates of the patient’s current medications in the Medication Profile.

To view a patient’s Medication Profile:

 On the Prescriptions window, right-click and then, in the SMART menu, click 
View Medication List. The EMR opens the patient’s Medication Profile, with a 
list of the patients current medications and corresponding start times displayed 
in the Medications area.
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You can make medication favourites for yourself, or you can make medication favourites that 
any prescriber in the clinic can use.

Adding medication favourites

When you create a prescription, you can add the prescription to your list of favourites at any 
time during the process. The selected medication, as well as any prescription directions you 
have entered are saved as part of the prescription favourite. 

Steps 

1. Start a prescription as normal, and enter any prescription directions in the Add New 
Medication window.

2. In the middle of the window, click the Favourites tab (if not selected already).

3. In the Description field, enter a name for the medication favourite.

Note: Medication Favourites can only be created for one medication at a time. You 
cannot create a favourite that includes multiple medications.

Note: Only prescription details entered in the Add New Medications window save 
as part of the favourite.
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4. To make the medication favourite available to all providers in your clinic, select the Clinic-
wide check box.

5. Click Add Favourite. The medication displays in your list of favourites. 

6. Complete the remainder of prescription as you would for a basic prescription. See Step 5 
Step 8 in “Creating basic prescriptions” on page 2. 

Creating prescriptions using favourites

If you have user-specific or clinic-wide medication favourites, when you prescribe a medication, 
a list of your favourites displays on the Add New Medications window, in the Favourites area. 
In the list of favourites, you can double-click a favourite to prescribe it. If your list of favourites is 
extensive, you can filter the list by entering a search term in the Search field.

Steps 

1. Open the Add New Medications window. See Step 1 in “Creating basic prescriptions” on 
page 2.

2. Click the Favourites tab (if it is not selected already).
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3. In the Search field, enter all or part of the medication name or favourite description, and then 
press Enter. In the favourites area, the EMR displays only matching medication favourites.

4. Double click the favourite you want. The EMR populates the Rx and prescription direction 
fields with the medication favourite default information. 

5. Modify the prescription details as needed. See Step 3 in “Creating basic prescriptions” on 
page 2.

6. Complete the remainder of prescription as normal. See Step 5 Step 8 in “Creating basic 
prescriptions” on page 2.

Managing your favourites

You can manage your list of prescription favourites by:

 Modifying the order of your listed favourites (see “Modifying the order of your favourites” 
on page 31)

 Editing the description and share settings of favourites (see “Modifying medication 
favourites” on page 32)

 Removing favourites (see “Removing favourites” on page 33)

All favourite management options are available right from the Add New Medications window, on 
the right side of the favourites area.

Modifying the order of your favourites

If you have numerous favourites for one medication, with each having different dosage 
directions, finding the medication favourite you want can be cumbersome. For this reason, you 
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can modify the order of your medication favourites list so that favourites with the most 
commonly prescribed dosage directions display higher on the list. 

Steps 

1. Open the Add New Medications window. See Step 1 in “Creating basic prescriptions” on 
page 2.

2. Click the Favourites tab (if it is not selected already).

3. In your list of medication favourites, click the favourite you want to move.
 

4. On the right of your medication favourites list, click either Move Up in Favourites List ( ) 

or Move Down in Favourites List ( ). The EMR moves the prescription favourite up or 
down a level. 

5. Continue to click the arrow until the medication favourite is located where you want. 

6. If you are not creating a prescription at this time, at the top of the Add New Medications 

window, click Cancel ( ). The EMR closes the Add New Medications window, and 
saves the modifications you made to your favourites list.

Modifying medication favourites

After you add a medication favourite, you can later modify the favourite’s description or share 
settings. You cannot modify the medication name or prescription details. If you want to edit the 
medication name or prescription details, you must remove the favourite (see “Removing 
favourites” on page 33), and then add a new favourite (see “Adding medication favourites” on 
page 29).

Steps 

1. Open the Add New Medications window. See Step 1 in “Creating basic prescriptions” on 
page 2.

2. Click the Favourites tab (if it is not selected already).

3. In your list of medication favourites, click the favourite you want to modify.

Tip: If your medication favourites list is extensive, in the Search field, enter all or 
part of the medication name or favourite description, and then press Enter. The 
EMR displays only matching favourites.

Tip: If your medication favourites list is extensive, in the Search field, enter all or 
part of the medication name or favourite description, and then press Enter. The 
EMR displays only matching favourites.
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4. To the right of your medication favourites list, click Edit ( ). The Edit Favourite window 
opens.

5. To edit the description for the medication favourite, in the Modify the description field, 
modify the text displayed.

6. To change the share settings for the medication favourite, click one of the following options:

 Personal: To make the favourite available on your list only.

 Clinic Wide: To make the favourite available to all clinic users.

7. If you are not creating a prescription at this time, at the top of the Add New Medications 

window, click Cancel ( ). The EMR closes the Add New Medications window, and 
saves the modifications you made to your favourites list.

Removing favourites

If you no longer use a certain prescription favourite, you can remove it from your list. Removing 
unnecessary favourites keeps your favourites list lean and easy to use.

Steps 

1. Open the Add New Medications window. See Step 1 in “Creating basic prescriptions” on 
page 2.

2. Click the Favourites tab (if it is not selected already).

3. In your list of medication favourites, click the favourite you want to remove.

4. To the right of your medication favourites list, click Remove Drug from Favourites ( ). 
The favourite is removed from your list.

5. If you are not creating a prescription at this time, at the top of the Add New Medications 

window, click Cancel ( ). The EMR closes the Add New Medications window, and 
saves the modifications you made to your favourites list.

Tip: If your medication favourites list is extensive, in the Search field, enter all or 
part of the medication name or favourite description, and then press Enter. The 
EMR displays only matching favourites.
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Viewing a patient’s medication profile
In a patient’s Medication Profile, you can view at-a-glance the patient’s current and previous 
medications, and current allergies and intolerances. For each medication, you can view:

 The patient’s current prescription directions

 A history of refills and prescription direction edits for the medication

Steps 

1. On any window related to a patient, right-click and then, in the SMART menu, choose View 
Medication List. The Medication Profile window opens, and displays the patient’s:

 Current (active) medications

 Previous medications 

 Allergies

By default, medications are listed in Alphabetical order.
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2. To re-sort the list so that medications are listed in chronological order by start date, click the 
Start Date column header.

3. To view detailed information about a medication and it’s prescription history:

a) In the patient’s Medications or Previous Medications lists, click the medication. In the 
right pane, the medication’s latest prescription directions are displayed. 

If there was an interaction warning for the prescription, and the prescriber entered an 
override reason for the warning, the following text displays in red text: “There is 1 drug 
interaction override recorded for this medication”. You can click this text to view the 
interaction warning(s) and the override reason.

If the patient has any lab results that are linked to this medication, the lab results are 
displayed in the Linked Lab Results area.

b) To view a history of discontinuations, dosage edits, and refills for the prescription, at the 
bottom of the window, click Medication History.

c) To view the refill history for the medication, click Refill History.

d) To view any interaction warnings for the medication, at the top of the window, click 
Multum.

4. If the patient is taking an anticoagulation medication (for example, warfarin), you can open 
the patient’s anticoagulation summary sheet: At the top of the window, click INR.

Note: Medications that display on the Active Medications list include: 

 Short-term medications that the patient is estimated to be currently or recently 
taking (based on prescription directions)

 Continuous medications that have not been discontinued (even if the 
medication is completed)

Note: When a prescription isprinted or refilled, it is documented in the Refill 
History.
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5. To view detailed information about a listed allergy or intolerance, in the Allergies area, 
double-click the allergy. The allergy opens in the Allergy List window.

Modifying patient medications and prescriptions
Once a prescription is created, the medication and it’s prescription history is recorded in the 
patient’s chart (first as an active medication, and then later as an previous medication). From the 
Medications list (and in some cases the Previous Medications list), you can:

 Edit prescription directions (see “Editing prescriptions” on page 36)

 Discontinue medications (see “Discontinuing medications” on page 37)

 Record adverse reactions to medications (see “Discontinuing medications due to 
adverse reactions” on page 38)

 Delete external medications (see “Deleting patient external medications” on page 40)

Editing prescriptions

If after you print a prescription you realize there is an error on the prescription, from the 
Medication Profile you can edit the prescription details and reprint the prescription. When you 
edit a prescription, the previous prescription is moved to the Previous Medications list, and the 
edited prescription is added as a new prescription. 

Steps 

1. Open the patients Medication Profile. See Step 1 in “Viewing a patient’s medication profile” 
on page 34.

2. In the Medications area, click the medication you want to edit. The EMR displays the 
medication’s prescription details in the right pane.

3. On the top right of the window, click Edit Medication Dosing ( ). The prescription 
opens in the Add New Medications window with editable fields.

4. Modify the prescription directions as needed. See Step 3 to Step 6 in “Creating basic 
prescriptions” on page 2.

5. Perform one of the following actions:

 To print the prescription on your default printer, click Quick Print ( ).

 To print the prescription on another printer, click Print ( ). The EMR displays a printer 
selection window. Click the printer you want, and then click Print.
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 To save the changes in the patient’s record, without printing the prescription, click Save 

& Close ( ). 

Discontinuing medications
When you instruct a patient to stop taking a medication, you should always discontinue the 
prescription in the patient’s EMR record. This way, the patient’s active medications list 
accurately reflects what medications the patient is currently taking. Also, in keeping a patient’s 
active medications list accurate, you will not receive interaction warnings against medications 
the patient is no longer taking.

When you discontinue a medication, you can record any adverse reactions to the medication at 
the same time.

Steps 

1. Open the patients Medication Profile. See Step 1 in “Viewing a patient’s medication profile” 
on page 34.

2. In the Medications area, click the medication you want to discontinue. The EMR displays 
the medication’s prescription details in the right pane.

3. On the top right of the window, click D/C Med. The Discontinue Medication window window 
opens, with the Date Discontinued defaulted to today’s date.

4. To record that the patient stopped taking the medication on a date earlier than today, in the 

Date Discontinued field, enter the date, or to select a date on a calendar, click . T

5. In the Reason drop-down list, select a reason for discontinuing the prescription. If the 
reason you want is not available, enter your reason in the Reason field.

Note: When a medication is discontinued, it can still be referenced or refilled from 
the patient’s Medication Profile. Discontinued medications are never permanently 
deleted from a patient’s record.
Managing medications and prescriptions using the Wolf EMR Legacy Prescriber - Issue 01.AA 37



Creating prescriptions and managing medications
6. Click Discontinue. The discontinued medication is moved to the Previous Medications 
area of Medication Profile window.

Discontinuing medications due to adverse reactions

If a patient has an adverse reaction to a medication, you can discontinue the medication and 
record the reaction in the patient’s medical record at the same time. 

Steps 

1. Open the patients Medication Profile. See Step 1 in “Viewing a patient’s medication profile” 
on page 34.

2. In the Medications area, click the medication you want to discontinue. The EMR displays 
the medication’s prescription details in the right pane.

3. On the top right of the window, click D/C Med. The Discontinue Medication window window 
opens, with the Date Discontinued defaulted to today’s date.

4. Click one of the following options:

 Allergy

 Adverse Rx

 Anaphylaxis. 

The Clinical Records window opens with the medication and reaction type already 
populated in the Allergy To area.
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5. Using the following table, record the allergy or intolerance details. 

Field Description

Certainty In the drop-down list, select one of the following options:

 Suspected: To indicate that an allergy is suspected but not 
confirmed.

 Confirmed: To indicate that an allergy is confirmed.

Severity In the Severity drop-down listed, select the level of severity the 
reaction was.

Symptoms In the drop-down list, select the symptom the patient experienced. 

If none of the options are appropriate, then enter the symptom into 
the Symptoms field.

Note Enter any additional notes about the reaction. 

If in the Reaction Type drop-down list, you selected Other, enter 
the reaction type here.

Date Noted This date defaults to today.

If the patient reported the reaction prior to today, enter the reported 
date. Use the format DD-MM-YYYY or click the down arrow and 
select a date from the calendar.
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6. Click Save & Close ( ). In the Medication Profile window, the discontinued medication 
is moved to the Previous Medications area. Allergy is also recorded in the patient’s list of 
allergies.

Deleting patient external medications

If you record an external medication for a patient in error (for example, you record a medication 
in the wrong patient’s record), you can permanently delete the medication from the patient’s list 
of medications as long has the medication has not been prescribed. 

Steps

1. Open the patients Medication Profile. See Step 1 in “Viewing a patient’s medication profile” 
on page 34.

2. In the Medications area, click the medication you want to delete and then, at the top of the 

window, click Delete Medication from Record ( ). The following WARNING window 
opens.

3. In the WARNING entry field, enter YES, and then click OK. The medication is permanently 
removed from the patient’s list of medications.

Refilling prescriptions
If a patient has previously been prescribed a medication, and the medication is listed in the 
patient’s active or previous medications, you can quickly refill the prescription.

You can:

Note: Medications can be permanently deleted only if the medication has not 
been prescribed.
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 Refill a prescription from a patient’s Medications list (see “Refilling a single prescription 
(for active medications)” on page 41)

 Resume a prescription from a patient’s Previous Medications list

 Refill prescriptions for multiple medications at once. 

If you refill prescriptions for multiple medications at once, you cannot modify the prescriptions’ 
directions before the prescriptions are printed. If you are refilling multiple prescriptions, but you 
want to modify the prescription directions for one or more of the prescriptions, you must refill the 
prescription for one medication at a time (see “Refilling a single prescription (for active 
medications)” on page 41). 

Refilling a single prescription (for active medications)

If you refill a prescription for one medication at a time, you can modify the prescription directions 
(for example, dose, duration, and frequency) before you print or save the refilled prescription. 

Steps 

1. On any window related to a patient’s medical record, right-click and then, in the SMART 
menu, click Refill Medications. The Prescriptions window opens.

2. In the Medications area, click the medication you want to refill. The EMR displays the 
medication’s prescription details.

3. To modify any of the prescription’s dose, frequency or duration details:

a) At the top of the window, click Edit Medication Dosing ( ).The prescription opens in 
the Add New Medication window.

b) Modify the prescription directions as needed, and then click Prescribe. See Step 3 in 
“Creating basic prescriptions” on page 2.

4. Enter or modify quantity, duration and refill directions as needed. See Step 6 in “Creating 
basic prescriptions” on page 2.

5. To refill another prescription:

a) In the Medications list, click the next medication you want to refill. The EMR displays a 
dialog box with the following prompt: “Save [medication name and prescription details] on 
prescription?.”

b) Click Yes. The EMR displays the word ******Refilled****** in front of the saved 
medication, and displays the saved medication in the Current Refill area (located on the 
bottom of the Prescriptions window).
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6. Once select all medications you want to refill, click Save & Close ( ). A dialog box 
opens with the following prompt: “Save [last medication name and prescription details} on 
prescription?.” 

7. Click Yes. A dialog box opens with the following prompt: “Print Prescription?”.

8. To print the refill, click Yes.

Resuming previous medications

If a patient has previously taken a medication, and the medication is listed in the patient’s 
Previous Medications list, you can easily resume the medication’s prescription without having to 
re-write the prescription. Resuming a medication creates a new prescription in the 
Medications list. The original prescription remains in the Previous Medications list.

Note: All medications that display in the Current Refill area on the Prescriptions 
window are included in the refill printout.
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Steps 

1. Open the patients Medication Profile. See Step 1 in “Viewing a patient’s medication profile” 
on page 34.

2. In the Previous Medications area, click the medication you want to resume.

3. At the top of the window, click Resume. A dialog box opens with the following message: 
“Refill <medication name, dose, and frequency> now?”

4. Click Yes. The Prescriptions window opens with:

 The resumed prescription’s details displayed

 The resumed prescription listed in the Medications area.

5. Complete the prescription. See Step 4 to Step 8 in “Refilling a single prescription (for active 
medications)” on page 41.

Refilling multiple prescriptions at once

If you want to quickly refill several medications at once without changing their original 
prescription directions (for example, if you are refilling a patient’s blister-pack), using the Multi-
Select check box, you can select which medications you want to refill, and then refill all 
selected medications in one click. When you refill multiple prescriptions via the Multi-Select 
check box, you:

 Can refill only medications listed in the patient’s Medications list

 Cannot modify any of the prescriptions’ dose, frequency, and quantity details

 Must have the same duration of therapy, and refills for all medications being prescribed

To refill medications listed in the patient’s Previous Medications list, or to modify the 
prescription directions for a medication you want to refill, you must refill each medication one-at-
a-time. See “Refilling a single prescription (for active medications)” on page 41 and “Resuming 
previous medications” on page 42.

Steps 

1. On any window related to a patient’s medical record, right-click and then, in the SMART 
menu, click Refill Medications. The Prescriptions window opens.

2. Above the Medications list, select the Multi-Select check box and then, in the 
Medications area, click the medications you want to refill.
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3. Modify information in the Quantity field, Repeats field, and Duration area as needed.

4. click Save & Close ( ). A dialog box opens with the following prompt: “Save [last 
medication name and prescription details} on prescription?.” 

5. Click Yes. A dialog box opens with the following prompt: “Print Prescription?”.

6. To print the refills, click Yes.

Managing refill requests from patients and pharmacies
When refill requests come in from a pharmacy, a nurse or MOA can queue the prescription and 
initiate a Refill Request. The request is sent to the provider for approval before the refilled 
prescription is sent back to the pharmacy.

Also, if you are a provider who is too busy to manually enter a patient’s prescription(s), you can 
instruct a resident or other clinical staff member to enter the prescription(s) (via a refill request) in 

Note: Any instructions you add/modify in the Quantity, Repeats, and Duration 
fields apply to all selected medications.
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advance of, or during a patient visit. You can then review the prescription, make modifications 
as necessary, and then print.

Using refill requests:

 Nurses and other clinical staff members can create and manage refill requests for providers 
(see “Sending refill requests to providers (front-end staff)” on page 45 and “Managing 
pharmacy callbacks using the Pharmacies to Call list (front-end staff)” on page 49)

 Providers can review, approve, modify or decline refill requests (see “Reviewing and 
responding to refill requests (providers)” on page 47)

Sending refill requests to providers (front-end staff)

When a pharmacy or patient requests a prescription refill, you can queue the prescription for 
the provider. When you finish queuing the prescription, the provider is notified and they can then 
choose to approve, modify or reject the queued prescription. From your WorkDesk, you can 
track and manage prescriptions that are approved or rejected. See “Managing pharmacy 
callbacks using the Pharmacies to Call list (front-end staff)” on page 49.

Steps 

1. From the WorkDesk, in the Data Entry area, click Refill Request. The Patient Search 
window opens.

2. Search for the patient and then double-click the patient’s name. The the Medication Refills 
window opens.

3. In the Pharmacy drop-down list, select the pharmacy requesting a refill for the patient.

4. In the Medications list, click the requested medication to refill. The Refill History area 
displays refill information for the medication.

Tip: If the pharmacy you want is not available in the list, from your WorkDesk, you 
can add a pharmacy. See “Managing your clinic’s pharmacy list” on page 52.
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Tip: If you do not see the requested medication in the list, you can add the 
medication.

Steps 

a) At the bottom of the Medication Refills window, click Add Medication to List 

( ). The Add New Medications window opens.

b) Enter the prescription directions similar to how a provider would. See “Creating 
prescriptions” on page 1.

Note: If you want the refill request to display in the provider’s list of refill requests to 
review, in the Prescriptions window, set the status of the prescription to 
Pending.
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5. Enter the Quantity and then ensure that Duration and Start Date are appropriate.

6. Click Close and Save ( ). A to dialog window opens, prompting you to confirm that 
you want to save the prescription. 

7. Click Yes. A dialog window opens, prompting you to confirm that you want to print the 
prescription.

8.  Perform one of the following actions:

 If you want to print the prescription for this single medication, click Yes. 

 If you do not want to print the prescription, or if you want to include more refilled 
medications on the prescription, click No.

The EMR returns you to the Medication Refills window.

9.  To add additional refills to the prescription, repeat Step 4 to Step 8.

10.Click Close Form. ( ).

Reviewing and responding to refill requests (providers)

If a front-end staff queues a prescription for a refill request, you are notified on your WorkDesk. 
From the WorkDesk, you can view, modify, and respond to your refill requests.
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Steps 

1. On your WorkDesk, in the Refill Requests area, click # Refills to be Approved. The 
Prescription Refill Requests window opens, with a list of pending refill requests.

2. Using the following table, respond to each refill request.

Tip: You can quickly view a patient’s medical record before responding to a refill 
request. To open a patient’s medical summary, on the refill request list, click the 
patient’s name.

To do this... Perform the following actions...

Reject a refill 
request

To the right of the pending refill request, in the status list, click 
Denied.

Indicate that 
the patient is to 
book an 
appointment for 
the refill

a) To the right of the pending refill request, in the status list, click To 
Come In.The EMR adds the patient to your front end staff’s 
Patient’s To Notify list, and displays a follow-up task window 
with your name selected in the To field.

b) On the Follow-ups window, in the Follow-up Reason field, add 
any additional details you want to display in the follow-up, and 

then click Save & Close ( ). 

Approve a refill 
request as-is

To the right of the pending refill request, in the status list, click 
Okayed.
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3. After you finish responding to each of the refill requests, click Save & Close ( ). The 
refill requests are removed from your list and your front-end staff are notified of the status 
changes.

Managing pharmacy callbacks using the Pharmacies to Call list (front-end staff)

When you send a refill request to a provider, you wait until the provider approves or denies the 
refill before you call the pharmacy. You can track which pharmacies are ready to be called using 
the Pharmacies to Call list. From this list, you can:

 View statuses (okayed, denied, or pending) of each refill request

 Cancel refill requests (if they have not been approved or declined)

 Indicate that you have called the pharmacy or patient who requested a refill

 Print prescription request reports

 Print prescriptions (if it has been approved by a provider)

Steps 

1. On your WorkDesk, in the Clinic Tasks area, click <#> pharmacies to call (where # = the 
number of pharmacies you need to call). The Pharmacies to Call list opens. 

Modify a refill 
before you 
approve it

a) In list of refill requests, click the medication name. The 
prescription displays in the Prescription Refill window.

b) Click Refill. The prescription opens in the Prescriptions window.

c) Enter and/or edit quantity and duration details as needed.

Note: If you want to edit dosage and frequency directions, at the 
top of the Prescriptions window, click Edit Medication 

Dosing ( ). The Add New Medication window opens.

d) Click Save & Close ( ). The EMR displays a dialog box with 
the following prompt: “Save [last medication name and 
prescription details} on prescription?.”

e) Click Yes. The EMR displays a dialog box with the following 
prompt: “Print Prescription?” 

f) To print the prescription, click Yes: otherwise, click No.

g) In the Refill Requests window, beside the edited refill, in the status 
list, click Okayed. 

To do this... Perform the following actions...
Managing medications and prescriptions using the Wolf EMR Legacy Prescriber - Issue 01.AA 49



Creating prescriptions and managing medications
2. In the Practitioner drop-down list, select the provider you want to manage refill requests for, 
or to view refill requests for all providers, leave <<ALL>> selected.

3. To view a list of queued prescriptions for a specific pharmacy, in the left pane, click the 
pharmacy. The right pane displays the patients requiring refills and their prescription 
information. The status of the refill request appears in red text. A status of:

 Okayed: Indicates the provider has approved the refill request

 Denied: Indicates the provider has denied the refill request

 Pending: Indicates the provider has not yet responded to the refill request

4. Using the following table, update or complete each of the refill requests.

To do this... Perform the following action(s)

Remove 
(cancel) a refill 
request (and 
also remove 
from the 
provider's list)

Note: Only refill requests in a state of Pending (ie. provider has not 
yet responded) can be removed.

Beside the refill request, click Done. When you close the 
Pharmacies to Call list, the refill request is permanently removed from 
the list, and from the provider’s list.
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5. To view any refill requests that were managed in the past 4 days, at the top of the 
Pharmacies to Call window, click Refill Log. 

6. When you finish managing your refill requests, click .

Edit a refill 
request

a) Beside the refill request, click Edit/Print. The refill opens in the 
Prescriptions window.

b) Edit the Quantity, Repeats, and Duration information as needed, 
or to edit the prescription frequency or dose, click Edit 

Medication Dosing ( ).

c) When you are finished editing, click Close & Save ( ).

Indicate that 
you have 
notified the 
pharmacy that 
the 
prescription(s) 
have been 
approved or 
denied

Note: Only refill requests in a state of Okayed or Denied can be 
marked as called.

Beside a refill request in a state of Okayed or Denied, click Done. 
The refill request is removed from the list. In the Refill Log, the refill is 
marked as Called.

Print a 
Telephone 
Prescription 
Refill response 
letter for the 
pharmacy

a) In the left pane, select the pharmacy you want to produce a letter 
for.

b) At the top of the window, click one of the following options:

 Quick Print ( ): To print the letter from your default printer.

 Print Report ( ): To print the letter from a selected printer.

The status of the refill request is changed to Printed.

c) To finish the refill request (move the refill request to the Refill Log), 
click Done.

Print an 
approved 
prescription

Beside the refill request, click Edit/Print. The refill opens in the 
Prescriptions window. You can now print the prescription as normal. 
See Step 8 in “Creating basic prescriptions” on page 2.

To do this... Perform the following action(s)
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Configuring and customizing features around medications and 
prescriptions

You can customize a number of features around medications and prescriptions. You can:

 Add, modify or remove pharmacies in your pharmacy list (see “Managing your clinic’s 
pharmacy list” on page 52)

 Set defaults for medication search options (see “Setting defaults for medication search 
options” on page 53)

 Set what medications are to print on prescriptions (all medications vs. medications 
prescribed by a selected provider) (see “Setting what medications are to print on 
prescriptions” on page 55)

 Configure if and how medication interaction warnings are to display when you prescribe 
medications (see “Configuring interaction warnings” on page 56)

 Modify prescription defaults for medications (see “Modifying prescription defaults for 
medications” on page 58)

 Choose to either include or hide patient medication lists on prescription printouts (see 
“Setting prescription printouts to include patient medication lists by default” on page 61)

 Add custom treatments to the medication list (see “Adding custom treatments to the 
medication list” on page 62)

Managing your clinic’s pharmacy list

You access the pharmacy list when you create a refill request, when you set a patient’s default 
pharmacy or when you select a pharmacy for a prescription. The pharmacy list is also a handy 
reference of all of the pharmacies that your clinic uses. You can access this list to look up 
pharmacy contact information, such as a fax number. Any user can add, modify or remove 
pharmacies via their WorkDesk menu. 

Steps 

1. On your WorkDesk menu, click Reference > Pharmacy/Facility List ( ). The Facility 
Information window opens.

2. In the Facility Type drop-down list, select Pharmacy.

3. To view and/or modify a pharmacy, in the Choose Pharmacy field, begin typing the 
pharmacy name and then, in the list of matching pharmacies, click the pharmacy. You can 
now modify information in any of the entry fields.
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4. To delete the pharmacy, click .

5. To add a pharmacy:

a) Click . The EMR displays an empty pharmacy form. 

b) At minimum, enter information in the Name, City, and Fax fields.

6. When you’re finished adding and modifying pharmacies, click .

Setting defaults for medication search options

When you prescribe or enter medications in patient charts, you can set what medication search 
options are selected by default. You can also choose how similar medication search matches 
must be to the search term, thus controlling how many search results are returned. If you have 
administrative rights in Wolf EMR, you can set defaults for the entire clinic; otherwise, you can 
set defaults for only yourself.

Steps 

1. Perform one of the following actions:

 If you are setting defaults for yourself, at the top of the WorkDesk window, click the 

Configure menu, and then choose Configure Workdesk ( ).

 If you are setting defaults for the entire clinic:
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a) On the Wolf EMR Launch page, click Configuration ( ). The Configuration 
window opens.

b) Click the Runtime Configuration tab, and then at the bottom of the window, click 
WorkDesk Preferences.

2. On the WorkDesk Preferences window, click the Medications tab.

3. Using the following table, set your clinic’s default medication search options. If you are 
setting preferences for yourself, clear the Apply Clinic Setting check box beside any 
options you are modifying.

To set a default for the following 
option... Do this...

a) Starts with vs Contains In the Medication search drop-down list, select 
the option you want selected by default.

a
d
e
f
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4. Click Save settings and exit ( ).

Setting what medications are to print on prescriptions

When a patient is prescribed more than one medication in a day, you can choose:

 if all medications prescribed that day, even if several providers prescribed medications, 
are to display on prescription printouts, or

 if all medications prescribed that day by a certain provider are to display on prescription 
printouts.

Steps 

1. Perform one of the following actions:

 If you are setting defaults for yourself, at the top of the WorkDesk window, click the 

Configure menu, and then choose Configure Workdesk ( ).

 If you are setting defaults for the entire clinic:

a) On the Wolf EMR Launch page, click Configuration ( ). The Configuration 
window opens.

b) Whether medication search 
matches can include medication 
names that are similar to the 
search term but don’t 
necessarily start with or contain 
the exact search term

Select or clear the Use partial match for 
medication search check box.

c) How similar medication names 
must be to be included in search 
matches

In the Degree of similarity for partial search 
drop-down list, select a level.

d) Include Generic Select or clear the Include Generics in search 
check box.

e) Include OTC Select or clear the Include OTC in search check 
box.

f) Include IV Select or clear the Include IV in search check 
box.

To set a default for the following 
option... Do this...
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b) Click the Runtime Configuration tab, and then at the bottom of the window, click 
WorkDesk Preferences.

2. On the WorkDesk Preferences window, click the Medications tab.

3. If you are setting preferences for yourself, beside Print Prescriptions for Today’s Date 
(per patient), clear the Apply Clinic Setting check box.

4. In the Print Prescriptions for Today’s Date (per patient) drop-down list, select an option.

5. Click Save settings and exit ( ).

Configuring interaction warnings

If you create prescriptions, you can control if and how you receive interaction warnings. You can 
specify if:

 Interaction warnings are to display as pop-up notifications

 You are to manually check for interaction warnings, without receiving pop-up notifications

 The EMR is not to check for interactions at all

Users with administrative authority in Wolf EMR can also set interaction warning defaults for all 
prescribers. Individual prescribers can then modify their own setings if desired.

Steps 

1. Perform one of the following actions:
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 If you are setting defaults for yourself, at the top of the WorkDesk window, click the 

Configure menu, and then choose Configure Workdesk ( ).

 If you are setting defaults for the entire clinic:

a) On the Wolf EMR Launch page, click Configuration ( ). The Configuration 
window opens.

b) Click the Runtime Configuration tab and then, at the bottom of the window, click 
WorkDesk Preferences.

2. On the WorkDesk Preferences window, click the Medications tab.

3. If you are setting preferences for yourself, beside Multum Drug Interaction, clear the 
Apply Clinic Setting check box and then, in the drop-down list, select one of the following 
options:

 

  
Option When the EMR identifies interactions...

Always On The EMR checks for interactions, and if any interactions are found, you 
receive a pop-up notification.

Note: When Always On is selected, the Multum button is not 
available.
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4. Click Save settings and exit ( ).

Modifying prescription defaults for medications

For a specific medication, you can set prescription defaults for:

 Dosing

 Anticoagulant designation

 Frequency

 PRN

 Duration

 Other Directions

When you prescribe the medication, no matter what strength you choose, prescription detail 
fields are populated automatically with the medication’s defaults. You can then edit the 
prescription details as needed, and complete the prescription as normal. Medication 
prescription defaults can save a significant amount of time as prescribers typically only need to 
modify one or two fields each time they prescribe the medication.

Medication prescription defaults apply only to simple prescriptions. They are not applied to 
sequential, concurrent, variable, adjust as directed, or external prescriptions. Defaults are set 
for all users only. You cannot set different defaults for individual users.

Steps 

1. On the Wolf EMR Launch page, click Configuration ( ).

2. In the Configuration menu, click View > Patient Reference Tables > Medication Index. 
The Medication Maintenance window opens.

3. In the Search tab, in the Medication Name field, enter part or all of the mediation name, 
and then click Search.

4. In the list of matching medications, click the medication you want to modify. In the Data tab, 
the EMR displays the medication’s default settings.

Always Off The EMR does not check for interactions, and you receive no warnings.

Note: When Always Off is selected, you cannot manually check if there 
are any interaction warnings. The Multum button is not available.

Manual The EMR checks for interactions, but does not notify you automatically. 
Instead, you can view any interaction warnings by clicking the Multum 
button. 

Option When the EMR identifies interactions...
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5. Using the following table, modify the medication’s prescription default settings as needed.
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To set a default value for 
the following field in the 
prescription Do this...

a) Dosage In the Pill Quantity drop-down list, enter the default dose.

b) Frequency In the Frequency drop-down list, select the default 
frequency.

c) Duration In the Duration drop-down list, select either:

 The default number of days or months

 No Cut Off or <None> to not populate the field with a 
default number of days or weeks, and to default the 
prescription as a continuous prescription. 

Note: If you select a specific number of days or weeks, the 
prescription defaults to a short term prescription.

d) PRN Select the PRN check box, to have PRN selected by 
default on the prescription.

e) Anticoagulation Select the Anti-Coagulation check box, to have the 
Anticoagulation check box selected by default on the 
prescription.

f) Notes In the Instructions area, enter the directions you want to 
display by default in the Other Directions field of the 
prescription (for example, “May be taken any time but 
evening is recommended”)

a

b

c
d

e

f
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6. Click Save Changes ( ).

Setting prescription printouts to include patient medication lists by default

If you have administrative rights in Wolf EMR, for each user who prescribes medications, you 
can choose if their prescription printouts are to include patient medication lists by default. 

When you set medication lists to display on prescription printouts by default, every time the 
prescriber creates a prescription, the Print Mediations check box is automatically selected. 

If the prescriber does not want the medication list to be included on a prescription print-out, 
they can choose to clear the Print Medications check box. This setting is user-specific, so 
you must enable or disable it for each prescriber individually. 

Steps 

1. On the Wolf EMR Launch page, click Configuration ( ). 

2. In the Configuration menu, click View > Physicians/Service Providers > Office Service 
Providers. The Physicians/Service Providers in Clinic window opens.

3. In the Office Service Provider drop-down list, select the provider you want to enable/
disable prescription medication lists for.

4. In the Other Data tab, in the Prescription Options area, select or clear the Print 
Medications on Rx check box.
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5. Click Save ( ).

Adding custom treatments to the medication list

If you regularly prescribe treatments that are not in Wolf EMR’s medication database (Multum), 
you can add these treatments to the medication list. This is most commonly used for non-
medication treatments such as physiotherapy, diaphragms, and crutches. After a custom 
treatment is added to the medication list, when you enter the treatment name in the Search 
field on the Add New Medication window, the treatment displays as an option in the medication 
search results. 
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Steps 

1. On the Wolf EMR Launch page, click Configuration ( ).

2. In the Configuration menu, click View > Patient Reference Tables > Medication Index. 
The Medication Maintenance window opens.

3. Click New Medication Record ( ).

4. In the Data tab, in the Medication Name field, enter the prescription name (as you want it 
to appear on prescriptions).
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5. Optionally, enter any default prescription details. See Step 5 in “Modifying prescription 
defaults for medications” on page 58.

6. Click Save Changes ( ).
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Questions?

WolfEMR.Support@telus.com 

1-866-879-9653 (Option 1)

https://telushealthcommunity.force.com/wolfcommunity

https://telushealthcommunity.force.com/wolfcommunity
https://telushealthcommunity.force.com/wolfcommunity
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